Functions and Equivalent Algebraic Expressions

On September 23, 1999, the Mars Climate Orbiter crashed on its first day of orbit. Two scientific groups used different measurement systems (Imperial and metric) for navigational calculations, resulting in a mix-up that is said to have caused the loss of the $125-million (U.S.) orbiter. Even though the National Aeronautics and Space Administration (NASA) requires a system of checks within their processes, this error was never detected.

This mix-up may have been caused by people not understanding complex equations. In general, to reduce the likelihood of errors in calculations, mathematicians and engineers simplify equations and expressions before applying them.

Example 1

Determine Whether Two Functions Are Equivalent

Determine whether the functions in each pair are equivalent by

i) testing three different values of \( x \)

ii) simplifying the expressions on the right sides

iii) graphing using graphing technology

a) \( f(x) = 2(x - 1)^2 + (3x - 2) \) and \( g(x) = 2x^2 - x \)
b) \( f(x) = \frac{x^2 - 2x - 8}{x^2 - x - 12} \) and \( g(x) = \frac{x + 2}{x + 3} \)

Solution

a) i) Choose three values of \( x \) that will make calculations relatively easy.

<table>
<thead>
<tr>
<th>( x )</th>
<th>( f(x) = 2(x - 1)^2 + (3x - 2) )</th>
<th>( g(x) = 2x^2 - x )</th>
</tr>
</thead>
</table>
| -1 | \( f(-1) = 2(-1 - 1)^2 + (3(-1) - 2) \)  
= \( 2(-2)^2 + (-5) \)  
= \( 8 - 5 \)  
= \( 3 \) | \( g(-1) = 2(-1)^2 - (-1) \)  
= \( 2(1) + 1 \)  
= \( 3 \) |
| 0 | \( f(0) = 2(0 - 1)^2 + (3(0) - 2) \)  
= \( 2(-1)^2 + (-2) \)  
= \( 0 \) | \( g(0) = 2(0)^2 - 0 \)  
= \( 0 \) |
| 1 | \( f(1) = 2(1 - 1)^2 + (3(1) - 2) \)  
= \( 2(0)^2 + 1 \)  
= \( 1 \) | \( g(1) = 2(1)^2 - 1 \)  
= \( 1 \) |
Based on these three calculations, the functions appear to be equivalent. However, three examples do not prove that the functions are equivalent for every x-value.

**ii)** In this pair, \(g(x)\) is already simplified, so concentrate on \(f(x)\).

\[
f(x) = 2(x - 1)^2 + (3x - 2)
\]
\[
= 2(x^2 - 2x + 1) + 3x - 2
\]
\[
= 2x^2 - 4x + 2 + 3x - 2
\]
\[
= 2x^2 - x
\]

Algebraically, these functions are equivalent.

**iii)** Use a graphing calculator to graph the two equations as \(Y_1\) and \(Y_2\).

Change the line display for \(Y_2\) to a thick line.

- Cursor left to the slanted line beside \(Y_2\).
- Press **ENTER** to change the line style.

- From the **ZOOM** menu, select **6:ZStandard**.

The graph of \(y = 2(x - 1)^2 + (3x - 2)\) will be drawn first. Then, the graph of \(y = 2x^2 - x\) will be drawn using a heavier line. You can pause the plot by pressing **ENTER**. Pressing **ENTER** again will resume the plot.

This seems to yield the same graph. These functions appear to be equivalent.

Using a TI-Nspire™ CAS graphing calculator, you can graph the functions \(f(x) = 2(x - 1)^2 + (3x - 2)\) and \(g(x) = 2x^2 - x\) side by side for comparison.
b) i)  

<table>
<thead>
<tr>
<th>x</th>
<th>( f(x) = \frac{x^2 - 2x - 8}{x^2 - x - 12} )</th>
<th>( g(x) = \frac{x + 2}{x + 3} )</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>( f(-1) = \frac{(-1)^2 - 2(-1) - 8}{(-1)^2 - (-1) - 12} )</td>
<td>( g(-1) = \frac{-1 + 2}{-1 + 3} )</td>
</tr>
<tr>
<td></td>
<td>( = \frac{1 + 2 - 8}{1 + 1 - 12} )</td>
<td>( \frac{1}{2} )</td>
</tr>
<tr>
<td></td>
<td>( = \frac{-5}{-10} )</td>
<td>( = \frac{1}{2} )</td>
</tr>
<tr>
<td></td>
<td>( = \frac{1}{2} )</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>( f(0) = \frac{0^2 - 2(0) - 8}{0^2 - 0 - 12} )</td>
<td>( g(0) = \frac{0 + 2}{0 + 3} )</td>
</tr>
<tr>
<td></td>
<td>( = \frac{-8}{-12} )</td>
<td>( = \frac{2}{3} )</td>
</tr>
<tr>
<td></td>
<td>( = \frac{2}{3} )</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>( f(1) = \frac{1^2 - 2(1) - 8}{1^2 - 1 - 12} )</td>
<td>( g(1) = \frac{1 + 2}{1 + 3} )</td>
</tr>
<tr>
<td></td>
<td>( = \frac{-9}{-12} )</td>
<td>( = \frac{3}{4} )</td>
</tr>
<tr>
<td></td>
<td>( = \frac{3}{4} )</td>
<td></td>
</tr>
</tbody>
</table>

Based on these three calculations, the functions appear to be equivalent. However, three examples do not prove that these functions are equivalent for every \( x \)-value.

ii) In this pair, \( g(x) \) is already simplified, so concentrate on \( f(x) \). To simplify \( f(x) \), factor the numerator and the denominator.

\[
f(x) = \frac{x^2 - 2x - 8}{x^2 - x - 12}
\]

\[
= \frac{(x - 4)(x + 2)}{(x - 4)(x + 3)}
\]

Factor the numerator and the denominator.

\[
= \frac{x + 2}{x + 3}
\]

Divide by the common factor.

Algebraically, it appears as though the two functions are equivalent. However, the effect of dividing by a common factor involving a variable needs to be examined.

iii) Use a graphing calculator to graph the two equations. In this case, there is a slight difference between the graphs. To see the graphs properly, press [ZOOM] and select [4:ZDecimal].

Technology Tip

Using a “friendly window,” such as [ZDecimal], makes it easier to see any gaps in the graph of a function. This is because each pixel represents one tick mark.
There appears to be a gap in the first graph. This can be verified further by using the TABLE function on a graphing calculator. Based on the evidence, this pair of functions is equivalent everywhere but at \( x = 4 \).

Polynomial expressions that can be algebraically simplified to the same expression are equivalent. However, with rational expressions, this may not be the case.

More specifically, since division by zero is not defined, you must define restrictions on the variable. For example, the function \( f(x) = \frac{x^2 - 2x - 8}{x^2 - x - 12} \) has a factored form of \( f(x) = \frac{(x - 4)(x + 2)}{(x - 4)(x + 3)} \). Since the denominator is zero if \( x - 4 = 0 \) or \( x + 3 = 0 \), the simplified function is written as \( f(x) = \frac{x + 2}{x + 3}, x \neq -3, x \neq 4 \).

Example 2

Determine Restrictions

Simplify each expression and determine any restrictions on the variable.

a) \( \frac{x^2 + 10x + 21}{x + 3} \)

b) \( \frac{6x^2 - 7x - 5}{3x^2 + x - 10} \)

Solution

a) \( \frac{x^2 + 10x + 21}{x + 3} = \frac{(x + 3)(x + 7)}{x + 3} \)  

\[ = \frac{(x + 3)(x + 7)}{x + 3}, x \neq -3 \]  

\[ = x + 7, x \neq -3 \]

So, \( \frac{x^2 + 10x + 21}{x + 3} = x + 7, x \neq -3 \).

b) \( \frac{6x^2 - 7x - 5}{3x^2 + x - 10} = \frac{(2x + 1)(3x - 5)}{(3x - 5)(x + 2)} \)

\[ = \frac{(2x + 1)(3x - 5)}{(3x - 5)(x + 2)}, x \neq -2, x \neq \frac{5}{3} \]

\[ = \frac{2x + 1}{x + 2}, x \neq -2, x \neq \frac{5}{3} \]

So, \( \frac{6x^2 - 7x - 5}{3x^2 + x - 10} = \frac{2x + 1}{x + 2}, x \neq -2, x \neq \frac{5}{3} \).
Example 3

Simplify Calculations

A square of side length 7 cm is removed from a square of side length $x$.

**a)** Express the area of the shaded region as a function of $x$.

**b)** Write the area function in factored form.

**c)** Use both forms of the function to calculate the area for $x$-values of 8 cm, 9 cm, 10 cm, 11 cm, and 12 cm. Which form is easier to use?

**d)** What is the domain of the area function?

**Solution**

**a)** $A_{\text{shaded}} = A_{\text{large}} - A_{\text{small}}$

$$= x^2 - 7^2$$

$$= x^2 - 49$$

**b)** $A_{\text{shaded}} = x^2 - 49$

$$= (x - 7)(x + 7)$$

**c)**

<table>
<thead>
<tr>
<th>$x$</th>
<th>$A = x^2 - 49$</th>
<th>$A = (x - 7)(x + 7)$</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>$A = 8^2 - 49$</td>
<td>$A = (8 - 7)(8 + 7)$</td>
</tr>
<tr>
<td></td>
<td>= 15</td>
<td>= 15</td>
</tr>
<tr>
<td>9</td>
<td>$A = 9^2 - 49$</td>
<td>$A = (9 - 7)(9 + 7)$</td>
</tr>
<tr>
<td></td>
<td>= 32</td>
<td>= 32</td>
</tr>
<tr>
<td>10</td>
<td>$A = 10^2 - 49$</td>
<td>$A = (10 - 7)(10 + 7)$</td>
</tr>
<tr>
<td></td>
<td>= 51</td>
<td>= 51</td>
</tr>
<tr>
<td>11</td>
<td>$A = 11^2 - 49$</td>
<td>$A = (11 - 7)(11 + 7)$</td>
</tr>
<tr>
<td></td>
<td>= 72</td>
<td>= 72</td>
</tr>
<tr>
<td>12</td>
<td>$A = 12^2 - 49$</td>
<td>$A = (12 - 7)(12 + 7)$</td>
</tr>
<tr>
<td></td>
<td>= 95</td>
<td>= 95</td>
</tr>
</tbody>
</table>

The areas are $15\text{ cm}^2$, $32\text{ cm}^2$, $51\text{ cm}^2$, $72\text{ cm}^2$, and $95\text{ cm}^2$, respectively.

Both expressions have similar numbers of steps involved. However, it is easier to use mental math with the factored form.

**d)** Since this function represents area, it must be restricted to $x$-values that do not result in negative or zero areas. So, the domain is $\{x \in \mathbb{R}, x > 7\}$.
Key Concepts

- To determine if two expressions are equivalent, simplify both to see if they are algebraically the same.
- Checking several points may suggest that two expressions are equivalent, but it does not prove that they are.
- Rational expressions must be checked for restrictions by determining where the denominator is zero. These restrictions must be stated when the expression is simplified.
- Graphs can suggest whether two functions or expressions are equivalent.

Communicate Your Understanding

C1 The points (−3, 5) and (5, 5) both lie on the graphs of the functions \( y = x^2 − 2x − 10 \) and \( y = −x^2 + 2x + 20 \). Explain why checking only a few points is not sufficient to determine whether two expressions are equivalent.

C2 A student submits the following simplification.

\[
\frac{x^2 + 6x + 3}{6x + 3} = \frac{x^2 + 6x + 3'}{6x^2 + 3'}
\]

\[= x^2\]

Explain how you would show the student that this is incorrect.

C3 Explain why the expression \( 4x^3 + 4x^2 − 5x + 3 \) does not have any restrictions.

Practise

For help with questions 1 to 6, refer to Examples 1 and 2.

1. Use Technology Use a graphing calculator to graph each pair of functions. Do they appear to be equivalent?
   a) \( f(x) = 5(x^2 + 3x − 2) − (2x + 4)^2 \),
   \( g(x) = x^2 − x − 26 \)
   b) \( f(x) = (8x − 3)^2 + (5 − 7x)(9x + 1) \),
   \( g(x) = x^2 − 10x − 14 \)
   c) \( f(x) = (x^2 + 3x − 5) − (x^2 + 2x − 5) \),
   \( g(x) = 2(x − 1)^2 − (2x^2 − 5x − 1) \)
   d) \( f(x) = (x − 3)(x + 2)(x + 5) \),
   \( g(x) = x^3 + 4x^2 − 11x − 30 \)
   e) \( f(x) = (x^2 + 3x − 5)(x^2 − 5x + 4) \),
   \( g(x) = x^4 − 2x^3 − 15x^2 + 37x − 20 \)

2. Refer to question 1. If the functions appear to be equivalent, show that they are algebraically. Otherwise, show that they are not equivalent by substituting a value for \( x \).

3. State the restriction for each function.

2.1 Functions and Equivalent Algebraic Expressions • MHR 83
4. State the restrictions for each function.
   a) \[ f(x) = \frac{x^2 + 11x + 30}{x + 6}, \quad g(x) = x + 5 \]
   b) \[ f(x) = \frac{x^2 - 16}{x^2 - 8x + 16}, \quad g(x) = x + 4 \]
   c) \[ f(x) = \frac{x^2 + 6x + 5}{x + 5}, \quad g(x) = x^2 \]
   d) \[ f(x) = \frac{x^2 + 10x + 16}{x^2 + 2x - 48}, \quad g(x) = \frac{x + 2}{x - 6} \]
   e) \[ f(x) = \frac{12x^2 - 5x - 2}{3x^2 - 2x}, \quad g(x) = \frac{4x + 1}{x} \]
   f) \[ f(x) = \frac{5x^2 - 23x - 10}{5x + 2}, \quad g(x) = -23x - 2 \]

5. Determine whether \( g(x) \) is the simplified version of \( f(x) \). If it is, then state the restrictions needed. If not, determine the correct simplified version.
   a) \( f(x) = \frac{x^2 + 11x + 30}{x + 6}, \quad g(x) = x + 5 \)
   b) \( f(x) = \frac{x^2 - 16}{x^2 - 8x + 16}, \quad g(x) = x + 4 \)
   c) \( f(x) = \frac{x^2 + 6x + 5}{x + 5}, \quad g(x) = x^2 \)
   d) \( f(x) = \frac{x^2 + 10x + 16}{x^2 + 2x - 48}, \quad g(x) = \frac{x + 2}{x - 6} \)
   e) \( f(x) = \frac{12x^2 - 5x - 2}{3x^2 - 2x}, \quad g(x) = \frac{4x + 1}{x} \)
   f) \( f(x) = \frac{5x^2 - 23x - 10}{5x + 2}, \quad g(x) = -23x - 2 \)

6. Simplify each expression and state all restrictions on \( x \).
   a) \( \frac{x - 8}{x^2 - 13x + 40} \)
   b) \( \frac{3(x - 7)^2(x - 10)}{x^2 - 17x + 70} \)
   c) \( \frac{x^2 - 3x - 18}{x^2 + x - 42} \)
   d) \( \frac{x^2 + 7x - 18}{x^2 + 3x - 10} \)
   e) \( \frac{x + 8}{x^2 - 6x - 16} \)
   f) \( \frac{25x^2 + 10x - 8}{10x^2 + 26x - 12} \)

B Connect and Apply

7. Evaluate each expression for \( x \)-values of \( -2, -1, 0, 3, \) and \( 10 \). Describe any difficulties that occur.
   a) \( (x - 6)(x - 2) - (x - 11)(x + 2) \)
   b) \( \frac{2x^3 + 12x^2 + 10x}{x^3 + 6x + 5} \)

For help with question 8, refer to Example 3.

8. A circle of radius \( 3 \) cm is removed from a circle of radius \( r \).

   a) Express the area of the shaded region as a function of \( r \).
   b) State the domain and range of the area function.

9. A company that makes modular furniture has designed a scalable box to accommodate several different sizes of items. The dimensions are given by \( L = 2x + 0.5, W = x - 0.5, \) and \( H = x + 0.5 \), where \( x \) is in metres.
   a) Express the volume of the box as a function of \( x \).
   b) Express the surface area of the box as a function of \( x \).
   c) Determine the volume and surface area for \( x \)-values of \( 0.75, 1, \) and \( 1.5 \) m.
   d) State the domain and range of the volume and surface area functions.
10. **Chapter Problem**  At the traffic safety bureau, Matthew is conducting a study on the stoplights at a particular intersection. He determines that when there are 18 green lights per hour, then, on average, 12 cars can safely travel through the intersection on each green light. He also finds that if the number of green lights per hour increases by one, then one fewer car can travel through the intersection per light.

a) Determine a function to represent the total number of cars that will travel through the intersection for an increase of \( x \) green lights per hour.

b) Matthew models the situation with the function \( f(x) = 216 - 6x - x^2 \). Show that your function from part a) is the same.

c) How many green lights should there be per hour to maximize the number of cars through the intersection?

11. In the novel *The Curious Incident of the Dog in the Night-Time* by Mark Haddon, the young boy, who is the main character, loves mathematics and is mildly autistic. Throughout the book, he encounters several math problems. One of the problems asks him to prove that a triangle with sides given by \( x^2 + 1, x^2 - 1, \) and \( 2x \) will always be a right triangle for \( x > 1 \).

a) Use the Pythagorean theorem to verify that this statement is true for \( x \)-values of 2, 3, and 4.

b) Based on the three expressions for the sides, which one must represent the hypotenuse? Justify your answer.

c) Use the Pythagorean theorem with the expressions for the side lengths to prove that these will always be sides of a right triangle for \( x > 1 \).

12. The function \( y = \frac{a^2}{x^2 + x^2} \) is sometimes called the witch of Agnesi after Maria Gaetana Agnesi (1718–1799). The equation generates a family of functions for different values of \( a \in \mathbb{R} \).

a) **Use Technology** Use graphing technology to graph this function for \( a \)-values of 1, 2, 3, and 4.

b) Explain why this rational function does not have any restrictions.

c) Research the history of Maria Gaetana Agnesi and find out who else studied this curve before her.

13. What does the graph of \( f(x) = \frac{(x + 6)(2x^2 - x - 6)}{x^2 + 4x - 12} \) look like?

14. Algebraically determine the domain and range of the area function that represents the shaded region.

15. A student wrote the following proof. What mistake did the student make?

\[
\text{Let } a + b. \\
\text{Then, } a^2 + ab. \\
\text{By adding } a^2 + ab. \\
2a^2 + a^2 + ab. \\
2a^2 - 2ab + a^2 + ab - 2ab. \\
2a^2 - 2ab + a^2 - ab. \\
2(a^2 - ab) + 1(a^2 - ab). \\
\text{Dividing both sides by } (a^2 - ab). \\
\text{gives } 2 = 1.
\]

16. **Math Contest** Given the two linear functions \( y = 6x - 12 \) and \( \frac{y}{x - 2} = 6 \), what ordered pair lies on the graph of the first line but not on the graph of the second line?
Graph Functions Using a TI-Nspire™ CAS Graphing Calculator

1. Open a new document. Open a page using the **Graphs & Geometry** application.

2. In the entry line, you will see $f_1(x) = \cdot$
   - Type $x^2$ as a sample function.
   - Press \( \cdot \).

   Note that the function is displayed with its equation as a label and the entry line has changed to $f_2(x) = \cdot$.

3. Look at the axes. This is the standard window.

   To view or change the window settings:
   - Press \( \cdot \).
   - Select 4:Window, and then select 1:Window Settings.

   You can change the appearance of the window.
   - Press \( \cdot \).
   - Select 2:View.

   There are several options. For example, if you select 8:Show Axes End Values, you can display the range of each axis.

4. Press the up arrow key once. The function $f_1(x)$ will be displayed in the entry line. You can change the appearance of a line:
   - Press \( \cdot \) until the Attributes tool, at the left of the entry line, is selected.
   - Press \( \cdot \).

   You can use this tool to adjust the line weight, the line style, the label style, and the line continuity.
   - Use the up and down arrow keys to highlight an attribute.
   - Then, use the left and right arrow keys to move through the options for that attribute.

   Experiment with the attributes. When you are finished, press \( \cdot \).

5. You can move a function label.
   - Press \( \cdot \). The entry line will grey out, and the cursor will move to the graphing window.
   - Use the arrow keys to move the cursor over the function label.

   When you are in the correct place, the word “label” will appear, along with a hand symbol.
• Press \( \frac{\text{alt}}{x} \). The hand will close to “grab” the label.
• Use the arrow keys to move the label around the screen.
• When you are finished, press \( \text{alt} \). You can also move the entire graph.
• Move the cursor to a blank space in the second quadrant.
• Press \( \frac{\text{alt}}{x} \). A hand will appear.
• Use the arrow keys to move the entire graph around the screen.
• When you are finished, press \( \text{alt} \).

6. You can display a table of values for the function.
• Press \( \text{alt} \) to return to the entry line.
• Press the up arrow key to return to the function \( f_1(x) \).
• Press \( \text{alt} \) and select 2:View.
• From the View menu, select 9:Add Function Table.
You can scroll up and down to inspect different values.
To adjust the Table Start value and the Table Step value:
• Press \( \text{alt} \) and select 5:Function Table.
• From the Function Table menu, select 3:Edit Function Table Settings.

7. You can split the screen to display two functions at once.
• Open a new document. Open a page using the Graphs & Geometry application.
• Graph the function \( f_1(x) = x^2 \).
• Press \( \frac{\text{alt}}{x} \) to access the Tools menu.
• From the Tools menu, select 5:Page Layout, and then select 2:Select Layout.
You will see a menu of possible layouts.
For example, to display two graphs side by side:
• Select 2:Layout 2. A blank window will appear.
• Press \( \frac{\text{alt}}{x} \) to switch windows.
• Press \( \text{alt} \) and select 2:Add Graphs & Geometry.
• Graph the function \( f_2(x) = x^3 \).